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ВВЕДЕНИЕ 

Advanced Design System (ADS) фирмы Agilent Technologies 
представляет собой одну из самых мощных систем проектирова-

ния с расширенными возможностями, которая предлагает разра-
ботчикам передовые технологии моделирования.  

Система ADS содержит все функции, которые необходимы для 
разработки и проектирования аналоговых и цифровых радиотех-
нических устройств, всего сигнального тракта устройств, провод-

ной или радиосвязи (включая связные системы и цифровую обра-
ботку модулирующих сигналов), проектирование печатных плат, 

разработку монолитных интегральных схем и пространственных 
электромагнитных структур, а также разводку печатных плат. 
Уникальные свойства системы ADS позволяют применять ее во 

многих областях техники, включая радиоэлектронику и лазерную 
технику. 

В библиотеках элементов ADS содержится описание более  
100 000 комплектующих изделий, а также средства разработки ин-
тегральных микросхем от ведущих производителей. Библиотеки 

проектирования ADS позволяют осуществлять разработку в соот-
ветствии с новейшими стандартами. Модели и методы моделиро-

вания, используемые в ADS, обладают высокой точностью и сте-
пенью достоверности. 

ADS является средой, которая совмещает несколько эффектив-

ных технологий моделирования. Она позволяет определять или 
импортировать высокочастотные, аналоговые и цифровые пара-

метры, а также ключевые параметры взаимодействия моделей. 
ADS предоставляет широкие возможности моделирования на 

системном, схемном и физическом уровнях в целях определения 
всех характеристик разрабатываемого изделия. Система ADS 
предлагает наиболее полный спектр технологий моделирования. 
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При совместном использовании они позволяют полностью харак-
теризовать и оптимизировать проектирование при множестве ус-
ловий.  

Важным качеством системы ADS является простота проекти-
рования, что способствует сокращению сроков разработки. Разви-

тая архитектура системы ADS дает возможность совместного мо-
делирования, что позволяет объединять типы и области 
моделирования.  

Связь со средой Agilent VEE обеспечивает управление прибо-
рами, комплексное манипулирование данными и их совместное 

применение, а также автоматизацию настройки схем измерения, 
позволяя создавать технические решения с учетом конкретных 
требований, необходимых для проверки правильности разработок. 

На всех стадиях процесса разработки анализ подсоединенных 
сигналов позволяет совместно использовать реальные и получен-

ные в результате моделирования сигналы, устройства и функцио-
нальные блоки. Варианты технических решений могут быть пол-
ностью исследованы без создания дорогостоящих макетов и 

выполнения дополнительных этапов проектирования. 
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1. СРЕДА ПРОЕКТИРОВАНИЯ 

Среда проектирования имеет оконный интерфейс. Все опера-

ции осуществляются внутри рабочей области текущего окна. 

1.1. Основы интерфейса ADS 

Главное окно, называемое Advanced Design System (Main), со-
держит главное меню и панель инструментов для быстрого досту-

па к основным операциям. Необходимые данные представлены в 
виде дерева каталогов, где показана иерархия текущего проекта 
(рис. 1.1). 

 

 
 

Рис. 1.1. Главное окно среды проектирования 

 
Из главного окна можно создавать проекты и управлять про-

ектами верхнего уровня и схемами; устанавливать набор необхо-
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димых пунктов меню; конфигурировать панели инструментов и 
назначать горячие клавиши; выбирать типы компонентов, загру-
жаемых во время запуска пакета; воспроизводить макросы, соз-

данные с помощью встроенного языка (Application Extension 
Language — AEL); формировать AEL-команды; запускать тексто-

вый редактор; открывать окно вывода результатов (Data Display 
Window) и др.  

Перед тем как начать работать с приложениями, необходимо 

выбрать тип проекта: Analog/RF, Digital Signal Processing или Both. 
Тип Analog/RF определяет работу в подсистеме моделирования 

аналоговых устройств. Тип Digital Signal Processing или Both зада-
ет работу в подсистеме проектирования цифровых устройств 
Ptolemy. Кроме того, тип Both используется для проектирования 

смешанных аналого-цифровых устройств. Уже созданный проект 
может работать только при совпадении текущего типа проекта с 

типом, определенным при создании проекта. Можно изменить эти 

опции, используя пункт меню Tools → Advanced Design System 
Setup в главном окне, при этом необходимо перезагрузить систему. 

При загрузке ADS также открывается выпадающее окно проек-
тов (рис. 1.2). 

Назначение кнопок панели инструментов показано на рис. 1.3. 
 

 

 
 
 

Рис. 1.2. Окно проектов 

 

Создание нового проекта 

 

Открытие имеющегося проекта 

 

Открытие недавно созданного проекта 

 

Открытие примеров проектов 

 

 

Обращение к справочному руководству 
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Рис. 1.3. Главное меню и панель инструментов 

 
Открыть окно справочного руководства можно, щелкнув мы-

шью по копке Quick Start Manual, которая находится в окне Ad-

vanced Design System (окно проектов). Также можно вызвать кон-
текстную справку, нажав кнопку Help в любом месте области 

проектирования и отображения данных. Окно справочного руко-
водства имеет вид, показанный на рис. 1.4. 

 

 

Рис. 1.4. Окно справочного руководства 
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Просмотр директории  

с примерами 

Поиск примеров 

Создание новых оконSchematic,  

Layout и отображения данных 

Свертывание 

всех окон 

Развертывание 

всех окон 



 8 

Файлы с примерами проектов можно открыть несколькими 
способами. 

Первый способ — выбрать кнопку 
 

, которая находится в 

главном окне Advanced Design System (окно проектов). Откроется 
окно файлов с примерами проектов (рис. 1.5). 

 
 

 

  
 

Рис. 1.5. Окно примеров проектов 

 

 

Второй способ — выбрать кнопку 
 

, которая находится в ок-

не Advanced Design System (Главное меню). Откроется окно фай-
лов с примерами проектов (рис. 1.6). 

Чтобы открыть файл проекта из примеров к программе Ad-
vanced Design System, необходимо выбрать из списка нужный про-
ект и дважды щелкнуть на его имени левой кнопкой мыши.  

Для поиска файлов с примерами проектов необходимо вы-

брать кнопку  в главном окне программы. Откроется окно по-
иска примеров проектов Example Search. Для примера выполним 

поиск проектов, в которых используется транзистор. В строку 
Query (Запрос) введем ключевое слово «transistor» и нажмем 

кнопку Search Now. В окне Results отобразятся все проекты с 
транзистором. Окно Example Search имеет вид, показанный на 
рис. 1.7. 

Примеры проектов 
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Рис. 1.6. Окно примеров проектов в главном окне 

 

 
 

Рис. 1.7. Окно более точного поиска примеров проектов 

Примеры проектов 
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Главное меню Панель инструментов 

Перечень  

компонентов 

Выпадающее меню  

компонентов  

Рабочая 

область 

1.2. Окно схемного редактора 

Окно схемного редактора содержит заголовок, меню, панель 

инструментов, панель быстрого доступа к необходимым компо-
нентам и область проектирования схемы. В окне схемного редак-
тора можно создавать и редактировать схему проекта, задавать 

переменные и уравнения, моделировать, открывать окно вывода 
результатов (рис. 1.18).  

 

 

 
 

 

 

 

Рис. 1.8. Окно схемного редактора 

 
В строке «Название проекта» указаны тип окна, тип проекта, 

имя файла и число-идентификатор, которое показывает, какое по 
счету окно проекта загружено. В главном меню отображаются 
пункты меню, доступные в данном редакторе. Выпадающее меню 

компонентов позволяет выбирать категорию компонентов, ото-
бражаемых в списке палитры. Выпадающее меню «История ком-

Название проекта История  

компонентов 

Быстрые  

сообщения 
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понентов» содержит список компонентов, которые уже были ис-
пользованы в данном сеансе работы.  

Рабочая область (область проектирования) — область, где рас-

полагается проект.  
Перечень компонентов содержит кнопки компонентов для раз-

мещения их в рабочей области окна.  
В строке «Быстрые сообщения» появляются сообщения о тех 

или иных командах, используемых в течение рабочего сеанса.  

Для открытия уже созданной схемы в меню File или File 
Brower следует выбрать имя нужного файла.  

В окне схемного редактора создается схема проекта. Панель 
инструментов окна схемного редактора показана на рис. 1.9. 
 

 
 

Рис. 1.9. Панель инструментов окна схемного редактора 

 

Кнопки панели инструментов окна схемного редактора имеют 
следующее назначение: 

 — создание новой схемы; 

 — открытие имеющейся схемы; 

 — сохранение текущей схемы; 

 — печать текущей схемы; 

 — окончание выполнения команды и возврат к выбранно-
му режиму; 

 — передвижение объекта; 

 — копирование объекта; 

 — удаление объекта; 

 — возврат к предыдущему шагу; 

 — отмена изменения точки входа; 

 — просмотр всей схемы; 

 — масштабирование указанной области; 
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 — масштабирование относительно указанной точки; 

 — увеличение в 2 раза; 

 — уменьшение в 2 раза; 

 — крупный (панорамный) вид указанного объекта; 

 — развертывание иерархии объекта; 

 — свертывание иерархии; 

 — вращение объекта по часовой стрелке  

 — зеркальное отображение объекта относительно оси x; 

 — зеркальное отображение объекта относительно оси y; 

 — деактивация или активация объекта; 

 — интеллектуальное моделирование; 

 — вставка порта (вход системы); 

 — вставка элемента заземления; 

 — вставка переменной величины; 

 — обращение к библиотеке компонентов; 

 — изменение параметров компонента; 

 — вставка (соединение) проводника; 

 — вставка названия провода; 

 — моделирование (симуляция); 

 — настройка параметров; 

 — открытие нового окна отображения данных; 

 — запуск сервиса обработки данных из файла. 

Схема создается размещением компонентов, портов, источни-

ков данных, модулей, переменных и т. д. При запуске программы 

загружается набор библиотек и компонентов по умолчанию. Мож-

но также конфигурировать загружаемые опции, при этом наиболее 

удобно выбирать тип проекта при старте системы ADS. 

Допуск к библиотеке элементов открывается нажатием кнопки 

Display Component Library List 
 

, которая находится на панели 

инструментов (рис. 1.10). 
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Рис. 1.10. Окно компонентов библиотеки ADS (фрагмент) 

 

Для быстрого поиска моделей компонентов нужно нажать кнопку 

Find Component(s) 
 

, появится окно, показанное на рис. 1.11. 

 

 
 

Рис. 1.11. Окно быстрого поиска компонента 

 
Когда модель компонента найдена, нужно выделить ее в окне 

Components и щелкнуть мышью в нужном месте схемы в рабочей 
области. Появится значок выбранного компонента и его модель. 
Проект создается размещением отдельных элементов в рабочей 

области окна.  
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Для доступа к отдельным компонентам используются специ-
альные команды: Browsing, Searching, Component Palette, Сompo- 
nent History. Все эти средства позволяют размещать отдельные 

элементы в рабочей области.  
Параметры компонентов можно редактировать, когда компо-

нент включается в схему и его параметры отображаются под его 
графическим обозначением. Значениями параметров могут быть 
арифметические выражения. Это особенно важно в иерархических 

проектах для передачи параметров компонентов верхнего уровня в 
компоненты нижнего уровня. Примером правильной записи в ка-

честве значения параметра является выражение x=pi/(2*order), где 
order — параметр, определенный для схемы или для символа 
верхнего уровня, pi — встроенная константа. Основные арифмети-

ческие операции — сложение (+), вычитание (-), умножение (*), 
деление (/) и возведение в степень (^). Эти операторы предназна-

чены для работы с целыми и вещественными (с плавающей точ-
кой) числами.  

В настоящее время все промежуточные вычисления выпол-

няются с двойной точностью, и только по окончании вычислений 
результат преобразуется к типу того параметра, который вычис-

лялся. Следовательно, необходимо соблюдать осторожность, на-
пример, используя для вычисления целочисленного параметра 
выражения, оперирующие вещественными числами. Для цело-

численного параметра все промежуточные значения вычисляются 
с двойной точностью, после чего результат приводится к цело-

численному значению. 

1.3. Окно моделирования 

Моделирование выполняется из окна схемного редактора. В 
рабочей области размещается необходимый элемент контроля ре-
зультатов моделирования в проекте, определяется имя проекта с 

данными, которые будут сгенерированы при моделировании. Для 
аналоговых схем используются категории элементов контроля: 

Envelop Simulation и Transient Simulation (для моделирования во 
временной области). Все данные, получаемые при моделировании, 
хранятся как Data Set (набор данных). Можно изменить имя проек-
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та до моделирования или оставить его по умолчанию, т. е. исполь-
зовать имя текущего проекта с расширением .ds.  

Окно моделирования появляется во время моделирования про-

екта и загружается автоматически. Окно содержит две информаци-
онные панели: Simulation / Synthesis Messages и Status / Summary.  

В первом окне соответственно отображаются сообщения об ошиб-
ках и проблемах, возникающих во время моделирования или син-
теза, а также причина, по которой возникла та или иная ошибка. В 

окне Status / Summary сообщается о ходе моделирования; если мо-
делирование прошло успешно, в нем появляется сообщение 

Simulation finished.  
 

 

а 

 

б 

 

Рис. 1.12. Окно моделирования: 
а — информационная панель сообщения об ошибках;  

б — информационная панель хода моделирования 

 

Отдельные элементы в окне схемного редактора можно деак-
тивировать, исключая их из моделирования, но не удаляя из про-

екта. Для этого нужно нажать кнопку Deactivate на панели инст-

рументов или выбрать пункт меню Edit → Component → 

→ Deactivate, затем выбрать отдельный элемент или несколько 

элементов, которые необходимо деактивировать. Для обратной 
операции — активации деактивированных элементов — использу-

ется команда Active из меню Edit → Item → Activate.  
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1.4. Окно отображения результатов моделирования 

Это средство служит для просмотра результатов моделирова-

ния. Данные могут быть представлены в различных форматах, ко-
ординатных сетках, можно сохранить их в файлах и затем исполь-
зовать в качестве шаблонов. Открыть окно Data Display можно из 

главного окна или из окна схемного редактора, выбрав пункт меню 

Window → New Data Display или нажав соответствующую кнопку 

панели инструментов (рис. 1.13). 
 
 

 

 
 

Рис. 1.13. Окно отображения результатов моделирования 

 
В строке-заголовке отображаются тип окна, имя файла и чи-

словой идентификатор. В меню File существуют три команды для 

сохранения отображаемых данных: Save (сохраняет изменения в 
текущем файле); Save As (сохраняет данные в файле с новым име-

нем); Save As Template (сохраняет некоторую информацию из об-
ласти рисования). Автоматически будет создан файл с расширени-

ем .ddt, информацию из которого при необходимости можно 
вставлять в любое окно данных.  

Меню  
Панель  

инструментов 
Панель графического  

представления 
Рабочая область 
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Открыть существующий файл данных в окне Data Display 

можно, выбрав Window → Open Data Display, указав имя файла и 
нажав кнопку OK. Для закрытия окна Data Display нужно выбрать 

пункт меню File → Close Window. Если данные в окне изменились, 
то система предложит сохранить их. 

 

 

 

Рис. 1.14. Разные виды отображения результатов моделирования 

 
Результаты моделирования сохраняются в специальном файле 

данных. Информацию из этого файла можно просмотреть в окне 

Data Display (рис. 1.14). В этом окне можно: отображать данные в 
виде различных графиков и в различных форматах; вставлять мар-

керы на графике для чтения данных в точке; записывать математи-
ческие выражения, которые позволяют выполнять сложные опера-
ции над данными; добавлять комментарии и рисованные объекты 

для улучшения документации.  
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2. ОСНОВНЫЕ ВИДЫ АНАЛИЗА ЛИНЕЙНЫХ  
И НЕЛИНЕЙНЫХ РАДИОТЕХНИЧЕСКИХ УСТРОЙСТВ 

В среде ADS поддерживаются следующие методы и виды ана-

лизов. 
Анализ по постоянному току (DC Simulation) является на-

чальным для всех остальных видов анализа; в процессе него быст-

ро проверяется топология устройства и проводится расчет рабочих 
точек схемы.  

Анализ по переменному току (AC Simulation) позволяет полу-
чить малосигнальные передаточные характеристики, такие как коэф-
фициенты передачи по напряжению, по току, шумовые напряжения и 

токи. Этот вид анализа полезен при проектировании пассивных уст-
ройств класса А (например, малошумящих усилителей ― LNA).  

Анализ S-параметров (S_Param Simulation) позволяет опре-
делить линеаризованные S- и шумовые параметры, передаточные 

проводимости и импедансы. Кроме того, он может быть использо-
ван и для достижения многих других целей малосигнального час-
тотного анализа.  

Анализ методом гармонического баланса (HB Simulation) 
используется для расчета установившихся режимов в нелинейных 

устройствах в частотной области. Этот вид анализа весьма полезен 
при проектировании радиочастотных усилителей, смесителей и 
генераторов. Реализованный в данной системе метод подпро-

странств Крылова позволяет существенно уменьшить объем ис-
пользуемой памяти ЭВМ и увеличить скорость расчета по сравне-

нию со стандартными подходами. Эта операция полезна при 
проектировании интегральных высокочастотных схем большой 
размерности, когда проектируемое устройство включает в себя 

большое количество активных приборов и необходимо учесть 
много гармонических и интермодуляционных составляющих.  
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Анализ большесигнальных S-параметров (LSSP Simula-
tion) осуществляется на основе метода гармонического баланса. 
Он необходим для того, чтобы оценить значения большесигналь-

ных параметров в нелинейных режимах мощных усилителей. 
Рассчитанные параметры могут быть использованы, например, в 

анализе на системном уровне.  

Анализ динамической характеристики (XDB Simulation) 
позволяет пользователю эффективно определить точку сжатия пе-

редаточной характеристики (когда реальная нелинейная зависи-
мость коэффициента передачи начинает отклоняться от идеализи-

рованной линейной), что очень важно при проектировании 
усилителей мощности. 

Анализ методом огибающей (Envelope Simulation) исполь-

зует комбинацию анализов в частотной и временной областях, 
что позволяет эффективно проводить полный спектральный ана-

лиз сложных сигналов, таких как дискретно-модулированные вы-
сокочастотные сигналы. Смысл анализа заключается в последо-
вательном применении метода гармонического баланса для ряда 

временных точек по несущей частоте на некотором отрезке. Это 
полезно при проектировании схем и систем, включающих моду-

ляторы/демодуляторы или работающих под воздействием сигна-
лов со сложной модуляцией. 

Анализ во временной области (Transient Simulation) позво-

ляет рассчитывать параметры нелинейных устройств методами 
численного интегрирования нелинейных дифференциальных 

уравнений во временной области, когда элементы устройства мо-
делируются приближенными эквивалентными схемами. 

Рассмотрим подробнее два типа анализа радиотехнических 
устройств, наиболее часто используемые в практических задачах. 

2.1. Анализ радиотехнических устройств  
по постоянному току 

Для проведения анализа радиотехнической схемы по постоян-

ному току необходимо выбрать из выпадающего меню компонен-
тов в окне схемного редактора категорию DC Simulation. В резуль-
тате такого анализа можно исследовать характеристики 

радиотехнических устройств по постоянному току, что позволит 
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определить потребляемую мощность схемы, получить передаточ-
ные вольт-амперные характеристики (ВАХ), определить токи и 
напряжения в исследуемых точках.  

Анализ можно проводить при изменении значений источников 
токов и напряжений, а также других параметров схемы. В режиме 

анализа по постоянному току автоматически проводится анализ 
статического режима схемы. 

В меню DC Simulation задаются следующие параметры  

(рис. 2.1
 

–
 

2.5).  
 

 
 

Рис. 2.1. Окно Sweep в меню DC Simulation 

 

Sweep ― задание изменяющихся параметров (см. рис. 2.1): 

• Parameter to sweep — запись имени изменяющегося пара-

метра; 

• Parameter sweep — выбор разновидностей изменяемых ти-

пов и других параметров; 
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• Sweep Type (см. рис. 2.2): 

o Single Point — выбор фиксированного значения пара-
метра; 

o Linear — выбор линейного закона изменения параметра; 
o Log — выбор логарифмического закона изменения па-

раметра;  
 

 

Рис. 2.2. Окно Sweep Type 

 

• Start / Stop — выбор начального и конечного значений из-

меняемого параметра; 

• Center / Span — выбор центрального значения параметра и 

отклонения при его изменении; 

• Start — начальное значение параметра; 

• Stop — конечное значение параметра; 

• Step-size — размер шага изменения параметра; 

• Num of pts — допускаемое число точек, для которых про-

водится анализ; 
Parameters ― задание параметров, соответствующих сходимо-

сти, статусу и уровням отображаемой информации (см. рис. 2.3):  

• Convergence:  

o Max.delta V — максимальное изменение узлового на-
пряжения, допускаемое на каждой итерации. По умол-

чанию принимается равным 0,1 В; 
o Max.iterations — максимальное число итераций, допус-

тимое при проведении анализа; 
o Mode — выбор алгоритма, по которому достигается 

сходимость:  
� Quick convergence test — использует результаты 

предварительных тестов, чтобы помочь предска-

зать, какую комбинацию параметров сходимости 
нужно тестировать. При этом применяется алго-

ритм Ньютона ― Рафсона для различных величин 
допускаемого шага (Max.delta V); 
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Рис. 2.3. Окно Parameters в меню DC Simulation 

 
� Robust convergence test — использует различные 

комбинации параметров сходимости (см. ниже); 
� Newton-Raphson — итеративный процесс, прекра-

щается, когда сумма электрических токов в каждом 

узле равна нулю для каждого узла и значения узло-
вых напряжений сходятся. Менее устойчив для 

средних и больших схем; 
� Forward source — level sweep — при решении мето-

дом DC Simulation устанавливает начальные значе-
ния напряжений всех DC-источников равными ну-
лю, затем изменяя их значения до требуемых; 

� Rshunt sweep — включает 1-омный резистор между 
каждым узлом и элементом заземления. Затем со-

противление резистора меняется до бесконечной ве-
личины, соответствующей режиму холостого хода; 
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� Revers source — level sweep — позволяет учесть 
эффект отрицательного сопротивления в идеальных 
моделях генераторов, описываемых уравнениями 
Ван-дер-Поля. Напряжения источников меняются в 
обратном направлении. Применяется достаточно 
редко; 

� Hybrid solver — использует возможности большин-
ства из вышеперечисленных алгоритмов для обес-
печения высокой скорости сходимости; 

� Pseudo Transient — показывает хорошую сходимость 
при анализе больших интегральных схем; 

• Levels ― выбор уровня выводимой информации:  

o Status level — варьирование уровеня выходной инфор-
мации;  

• Device operating point level ― выбор уровня выводимой ин-

формации о рассчитанных рабочих точках. Определяется в 

окне Simulate в главном меню при редактировании дополни-
тельных опций анализа статического режима:  

o None — отсутствие выводимой информации; 
o Brief — вывод рабочих точек только для определенных 

пользователем активных приборов; 
o Detailed — вывод рабочих точек для всех активных 

приборов схемы; 
• Output solutions: 

o Output solutions at all steps — сохранение всех получае-
мых решений в блоке данных (повышает сходимость 
решения при повторном анализе).  

Output ― отображение выходных параметров (см. рис. 2.4): 
• Save by hierarchy — сохранение иерархии: 

o Maximum Depth — задание определенного уровня ие-
рархии; 

o Node Voltages — вывод всех данных в иерархическом 
проекте до определенного уровня; 

o Measurement Equations — вывод всех данных в иерар-
хическом проекте до определенного уровня; 

o Save by name — лист узлов и уравнений, явно указан-
ных во вторичном диалоговом окне Add / Remove (До-
бавить / Удалить). 
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Рис. 2.4. Окно Output в меню DC Simulation 

 

Display ― отображает параметры в окне схемного редактора. 
Используется для того, чтобы показать или скрыть все возможные 
параметры при моделировании (см. рис. 2.5):  

• Display parameters on schematic — позволяет выбрать те 
параметры, которые необходимо показать на изображении 
схемы; 

• Set All — показывает все параметры; 
• Clear All — скрывает все параметры. 
Особенностью анализа по постоянному току является то, что 

он выполняется автоматически перед малосигнальным частот-
ным анализом, анализом во временной области и анализом ме-
тодом гармонического баланса. Поэтому при некорректном за-
вершении анализа по постоянному току (например, неверное 
соединение элементов, отсутствие сходимости), все перечис-
ленные выше виды анализов проводиться не будут.  
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Рис. 2.5. Окно Display в меню DC Simulation 

 

Линейные элементы замещаются их проводимостями на нуле-
вой частоте. Конденсаторы, микрополосковые разрывы, связанные 
линии рассматриваются как разомкнутые цепи. Индуктивности, 

проводящие нерегулярности рассматриваются как короткозамкну-
тые цепи. Линии передачи замещаются элементами с постоянной 

проводимостью, значения которой определяется их длиной. «Чер-
ные ящики», представляемые файлами в виде S-параметров, долж-

ны иметь компоненты на нулевой частоте.  
Анализ статического режима проводится на основании итера-

ционной процедуры. Модифицируя рассмотренные ранее крите-

рии сходимости, регулируют точность и скорость расчета. Так, 
можно увеличить максимальное число итераций. Если проводится 

анализ в диапазоне значений источников, то лучше всего умень-
шать шаг их изменения, так как полученные на предыдущем шаге 
результаты используются в качестве начального приближения для 
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следующей точки. Допускается также регулировать уровень 
ошибки расчета.  

Перед запуском анализа по постоянному току автоматически 

проверяется топология схемы по следующим критериям: в узле 
должно быть соединено не менее двух компонентов; DC-

источники не должны быть заземлены. Проверка не выявляет вы-
шеуказанные дефекты для трансформаторов или линий передач.  

При обнаружении ошибок в топологии дефектные узлы подсве-

чиваются в окне Simulation / Synthesis Messages (см. рис. 1.12, а). 

Для их идентификации нужно выбрать опцию Simulate → 

→ Highlight Node. Для обнаружения несоединенных линий или вы-

водов элементов нужно воспользоваться опцией Options → Check 

Representation → Unconnected pins.  
Если сходимость решения не достигается за данное число ите-

раций, то число итераций можно увеличить следующим образом: в 
окне DC Simulation выбрать команду Parameters и установить боль-

шее значение параметра Max.Iterations. 
Если при анализе существенно нелинейных режимов алгорит-

мом по умолчанию обнаружена несходимость, следует воспользо-

ваться другими алгоритмами с помощью опции Parameters. 
Другой подход к решению проблемы сходимости — установка 

больших значений параметров контроля сходимости с помощью 

опции Component Palette List → Options → Convergence → DC 

Convergence → Tolerances с использованием следующих команд:  

– Voltage relative tolerance — относительная ошибка расчета 
узловых напряжений методом Ньютона на итерации (по умолча-
нию 10–6); 

– Voltage absolute tolerance — абсолютная ошибка расчета уз-
ловых напряжений (по умолчанию 10–6 В); 

– Current relative tolerance — относительная ошибка определе-
ния токов ветвей (по умолчанию 10–6); 

– Current absolute tolerance — абсолютная ошибка расчета то-

ков (по умолчанию 10–6 А).  
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2.2. Анализ радиотехнических устройств  
во временной области 

Анализ во временной области позволяет моделировать пере-
ходные процессы с помощью контроллера переходных процессов. 
Контроллер (Tran) моделирования переходных процессов позволя-
ет определить следующие аспекты симуляции (рис. 2.5, 2.6). 

 

 
 

Рис. 2.6. Окно Transient / Convolution Simulation  

(меню Time Setup, Integration, Convolution, Convergence, Options) 

 
Time Setup (Установка временных параметров) ― задание па-

раметров, связанных со временем и частотой.  
Integration (Интегрирование) ― выбор метода интегрирования 

и диапазона изменения параметров, подключение шумов источни-
ка и резистора, задание параметров прибора. В этом режиме также 
доступны дополнительные варианты для анализа осцилляторов.  

Convolution (Свертка) ― определение параметров, относящих-
ся к установкам с использованием механизма сверток.  
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Рис. 2.7. Окно Transient / Convolution Simulation  

(меню Noise, Freq, Output, Display) 

 
Convergence (Сходимость) ― задание параметров, связанных с 

достижением сходимости.  
Options (Опции) ― задание параметров, связанных с имитаци-

ей, и сообщение об уровнях полноты отчетов и сохраняемых дан-
ных уровня рабочей точки.  

Noise (Шум) ― установка ширины полосы и задание масштаба 
шума. 

Freq (Частота) ― задание параметров для основных частот, 

которые используются для вычисления начальных частот в методе 
баланса гармоник.  

Output (Выходные данные) ― выборочное сохранение резуль-
татов симуляции в виде набора данных.  

Display (Отображение) — отображение результатов симуляции 

работы схемы.  
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3. ИССЛЕДОВАНИЕ ПРОЦЕССОВ  
АМПЛИТУДНОЙ МОДУЛЯЦИИ И ДЕТЕКТИРОВАНИЯ  

ЭЛЕКТРОМАГНИТНЫХ КОЛЕБАНИЙ  
В СРЕДЕ ADVANCED DESIGN SYSTEM 

Цель работы — изучение физических процессов, происходя-

щих в схемах амплитудной модуляции и детектирования ампли-
тудно-модулированных сигналов с использованием моделирова-
ния в среде ADS. 

3.1. Основные теоретические положения 

Модуляция и детектирование — это нелинейные электромаг-

нитные процессы, которые сопровождаются преобразованием 
спектра частот входного колебания.  

Модуляция — это изменение одного из параметров высокочас-

тотного колебания (амплитуды, частоты, фазы) по закону низко-
частотного передаваемого сообщения.  

Цель модуляции состоит в переносе спектра низкочастотного 
сигнала в область высоких частот для передачи сигналов. Высокая 
частота, на которой осуществляется передача сигнала, называется 

несущей частотой. Частота изменения параметра высокочастотно-
го колебания называется модулирующей частотой. 

При амплитудной модуляции (АМ) по заданному закону изме-
няется амплитуда несущего колебания. 

Аналитическое выражение АМ-сигнала можно записать как 

 
AM 0 0 0

( ) [1 ( )]cos( ),u t U mf t t= + ω +ϕ  (3.1) 

где U0 — амплитуда несущего колебания; m — коэффициент мо-

дуляции;  f(t) — модулирующая функция; ω0 — частота АМ-

сигнала; ϕ0 — фаза АМ-сигнала. 
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При гармонической модуляции АМ-сигнал можно записать в виде 

 
AM 0 0 0

( ) [1 cos ]cos( ),u t U mc t t= + Ω ω +ϕ  (3.2) 

Коэффициент модуляции можно определить как 

 max min

max min

U U
m

U U

−

=

+

, (3.3) 

где Umax и Umin — соответственно максимальное и минимальное 
значение амплитуды высокочастотного колебания. 

АМ-колебание можно представить в графической форме 
(рис. 3.1). 

 

 
 

Рис. 3.1. Временное представление АМ-колебания 

 

АМ-колебание можно представить в виде суммы гармониче-
ских колебаний: 

AM 0 0 0 0 0 0

0 0 0

cos( ) cos[( ) ]
2

cos[( ) ].
2

m
u U t U t

m
U t

= ω + ϕ + ω + Ω + ϕ +

+ ω − Ω + ϕ

 

(3.4)

 

Из выражения (3.4) видно, что АМ-колебание является суммой 
трех высокочастотных гармонических колебаний на близких час-

тотах (так как Ω << ω0): 
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U0 — амплитуда несущего колебания с частотой ω0; 

в 0
2

m
U U=  — амплитуда колебания верхней боковой состав-

ляющей с частотой ω0 + Ω; 

н 0
2

m
U U=  — амплитуда колебания нижней боковой состав-

ляющей с частотой ω0 – Ω. 

Спектр АМ-колебаний показан на рис. 3.2. Ширина спектра 

равна удвоенной частоте модуляции: ∆ΩАМ = 2Ω. Амплитуда не-
сущего колебания при модуляции не изменяется; амплитуды коле-

баний боковых составляющих спектра (верхней и нижней) про-
порциональны глубине модуляции. При m = 1 амплитуды 

колебаний боковых составляющих спектра достигают половины 
амплитуды несущей.  

 

Рис. 3.2. Спектр АМ-колебания 

 
Для осуществления АМ необходимо выполнить перемножение 

несущего и модулирующего колебаний (формула (3.2)). АМ мож-
но получить, используя нелинейные цепи.  

АМ можно осуществить с помощью цепей, содержащих нели-

нейные элементы, ВАХ которых можно аппроксимировать квадра-
тичной зависимостью (диоды, биполярные транзисторы, полевые 

транзисторы, лампы). 
На практике в качестве нелинейных элементов модуляторов 

чаще всего используют не диоды, а транзисторы или лампы (трио-

ды, пентоды). Модулируемое высокочастотное напряжение пода-
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ют во входную цепь нелинейного элемента (в цепь базы, затвора, 
сетки). Модулирующий сигнал вводят в цепь различных электро-
дов: в транзисторах — в цепь базы (затвора) или коллектора (сто-

ка); в электронных лампах — чаще всего в цепь управляющей сет-
ки (сеточная модуляция) или анода (анодная модуляция). 

Коллекторная (анодная) модуляция обеспечивает более высокий 
КПД, чем базовая. Однако для ее осуществления требуется более 
мощный источник модулирующего сигнала. Отметим, что при ма-

лых уровнях входных сигналов для модуляции используется квад-
ратичность входной характеристики прибора (как в диодных мо-

дуляторах). 
Схема амплитудного модулятора с управлением по входу (базо-

вого модулятора на биполярном транзисторе) приведена на рис. 3.3. 

В этой схеме модулирующий низкочастотный и модулируемых 
высокочастотный сигналы подаются на базу транзистора.  

 

 
 

Рис. 3.3. Схема амплитудного модулятора с управлением по входу 

 
Под воздействием модулирующего сигнала напряжение сме-

щения на базе Uб меняется с частотой модуляции Ω. Это приводит 
к тому, что импульсы коллекторного тока отличаются друг от дру-

га амплитудой Imax и углом отсечки θ. При подаче модулирующего 

сигнала uΩ амплитуда Imax и ширина θ импульсов тока меняются во 
времени, что приводит к изменению амплитуды первой гармоники 
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Iк1 с низкой частотой Ω. Поэтому выходное напряжение получает-
ся модулированным по амплитуде. Выделение высокочастотного 
АМ-колебания осуществляется колебательным контуром, вклю-

ченным в коллекторную цепь и настроенным на частоту несущей. 
При осуществлении модуляции могут возникнуть искажения, 

заключающиеся в отклонении формы огибающей АМ-колебаний 

от формы модулирующего сигнала UΩ. Для получения неискажен-
ной АМ требуется, чтобы Iк1 изменялась пропорционально изме-

нению напряжения смещения.  
Модуляционную характеристика представляет собой зависимость 

амплитуды первой гармоники Iк1 от напряжения смещения Еб при 

постоянной амплитуде высокочастотного колебания Uω (можно так-
же строить зависимость амплитуды первой гармоники напряжения на 
контуре). При работе на линейном участке модуляционной характе-

ристики АМ осуществляется без нелинейных искажений. 
Детектирование — процесс восстановления низкочастотного 

восстановления низкочастотного сигнала по модулированному 
высокочастотному колебанию. Детектирование считается неиска-
женным, если напряжение на выходе детектора повторяет закон 

изменения амплитуды модулированного колебания в случае АМ. 
Поскольку в спектре модулированного колебания содержатся 

только высокочастотные компоненты (несущая и боковые частоты), а 
результатом детектирования является получение низкочастотных ко-

лебаний, для детектирования необходимы нелинейные цепи. Схема 
амплитудного детектора состоит из нелинейного преобразователя, в 
выходном токе которого при воздействии на вход гармонического 

напряжения Uвx = U cos (ωt + ϕ) появляется постоянная составляю-
щая, и фильтра нижних частот, предотвращающего прохождение на 
выход детектора высокочастотных составляющих.  

В качестве нелинейного элемента в детекторах наиболее часто 
используется полупроводниковый диод. Для выделения полезного 

низкочастотного сигнала последовательно с диодом включена RC-
цепь. Для правильной работы схемы сопротивление R и конденса-
тор С должны удовлетворять следующим условиям: 

 
0 в

1 ( ) 1 ( )C R Cω << << Ω , (3.5) 

где Ωв — наивысшая частота в спектре модулирующего колебания. 
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Рис. 3.4. Амплитудный детектор 

 

При детектировании, как и при модуляции, происходит преоб-
разование спектра входного колебания. На выходе получается коле-
бание с частотой, отсутствующей во входном колебании (рис. 3.5). 

 

 

Рис. 3.5. Спектр сигнала на выходе амплитудного детектора 

 

Основной характеристикой детектора является характеристика 
детектирования, которая представляет собой зависимость постоянной 
составляющей выходного тока от амплитуды напряжения U. В зави-

симости от амплитуды входного сигнала детектор может иметь ли-
нейную или квадратичную характеристику детектирования. При 

больших сигналах (U > 0,5 В) диодный детектор имеет линейную ха-
рактеристику детектирования, при малых сигналах (0 < U < 0,1 В) — 
квадратичную. 
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3.2. Задание и порядок выполнения работы 

1. Создать проект, присвоив ему имя, например modulyator_prj. 
2. В среде ADS в окне схемного редактора подготовить схему 

(design) макета амплитудного модулятора с управлением по входу 
и амплитудного детектора с фильтром низких частот. 

3. Проанализировать работу амплитудного модулятора с ис-
пользованием ADS. Получить сигнал на выходе модулятора. Про-
вести расчет модуляционной характеристики модулятора. Иссле-

довать зависимость коэффициента модуляции от амплитуды 
модулирующего напряжения. 

4. Проанализировать работу амплитудного детектора с исполь-
зованием ADS. Получить сигнал на выходе детектора. Рассчитать 
характеристику детектирования амплитудного детектора. 

3.3. Анализ работы амплитудного модулятора  

с амплитудным детектором 

Для создания схемы в схемном редакторе ADS необходимо 
выполнить следующее. 

1. Внести в схему транзистор ap_npn 2N3946, диод ap_dio 
1N649, пользуясь библиотекой. Для этого нажать кнопку Display 

Component Library List. Для быстрого нахождения транзистора или 
диода нажать кнопку Find Component(s). В появившееся окно за-
писать название прибора. Когда модель компонента найдена, нуж-

но выделить ее в окне Components. В рабочей области появится 
значок выбранного компонента и его модель. 

2. Разместить в окне схемного редактора пассивные элементы с 

сосредоточенными параметрами из группы Component Palette List → 

→ Lumped-Components. Выбрав значок нужного пассивного эле-

мента (R, L, C), перенести его в рабочую область. В окне парамет-
ров элементов задать значения их параметров.  

3. Выбрать компонент Component Palette List → Sources-

TimeDomain → V_DC. Разместить DC-источник на схеме в кол-
лекторной цепи и задать требуемое значение (25 В). Разместить 
DC-источник на схеме в базовой цепи и задать требуемое значение 

его параметра (0,7 В). 



 36 

4. Выбрать компонент Component Palette List → Sources-

TimeDomain → VtSine. Разместить VtSine-источники (V2 — амплиту-
да 0,4 В, частота 1 кГц), (V3 — амплитуда 0,4 В, частота 50 кГц) на 
схеме в базовой цепи и присвоить требуемые значения его параметрам.  

5. Выбрать компонент Component Palette List → Sources-Time 

Domain → I_DC. Разместить источник тока в базовой цепи и при-
своить требуемое значение его параметру.  

6. Выбрать компоненту Component Palette List → Probe Compo-

nents → I_Probe. Расположить амперметр между коллектором и 
первичной обмоткой трансформатора.  

7. Соединить проводниками компоненты, размещенные в окне 
схемного редактора, с помощью команды Wire. 

8. Присвоить имена тем узлам схемы, в которых необходимо 
определить напряжение, используя опцию меню схемного редак-

тора Insert → Wire/Pin Lable или нажать пиктограмму Insert 
Wire/Pin Lable. 

9. Все изолированные замкнутые контурные цепи обязательно 

обеспечить заземлением. Общий вид скомпонованной схемы пока-
зан на рис. 3.6. 

10. Для анализа переходных характеристик выбрать контрол-

лер анализа переходных процессов Component Palette List → Simu-

lation → Transient → Tran и задать временные параметры анализа в 
диалоговом окне Time Setup: Start Time, Stop Time, Max Time Step, 

Min Time Step.  

11. Начать моделирование командой главного меню Simulate → 

→ Simulate или нажать кнопку Simulate меню инструментов. 
12. Наблюдать в окне моделирования отображение процесса 

выполнения работы активных контроллеров, оценку общего вре-

мени, затраченного на симуляцию, общую оценку результата и 
сообщения об ошибках. 

13. По завершении симуляции автоматически открывается но-

вое или подготовленное ранее окно отображения результатов мо-
делирования (данных). Форма представления — таблица или гра-

фик. Вид графика в прямоугольных координатах можно выбрать в 
панели графического представления. Окно отображения результа-
тов моделирования амплитудного модулятора и детектора показа-

но на рис. 3.7.  
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Рис. 3.6. Схема амплитудного модулятора и детектора в ADS 

 
14. Для получения спектра сигналов в окне просмотра выход-

ных данных нужно разместить компонент Eqn, описывающую 
вводимое уравнение: spectr2=fs(V3,,,,,,,0ms,3ms). Здесь spectr2 — 

имя рассчитываемой спектральной характеристики (назначается 
пользователем); fs — имя библиотечной функции, реализующей 

фурье-анализ, V3 — имя напряжения в узле, для которого произ-
водится вычисление спектра; 0ms, 3ms — начальное и конечное 
значения временного интервала для фурье-анализа. Можно изме-

нить интервалы, не прибегая к повторному моделированию схемы. 
Из девяти аргументов функции fs() только один — имя преобра-

зуемой переменной — является обязательным. Значения необяза-
тельных переменных функции fs() могут не подставляться, а их 
место отмечается запятыми. Для получения детальной информа-

ции в окне Eqn нужно нажать кнопку Functions Help. 
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Рис. 3.7. Окно отображения результатов моделирования  

амплитудного модулятора и детектора 

 
15. Получить модуляционную характеристику модулятора 

Ic1=f(Eб), где Eб=V1, а Ic1 — амплитуда первой гармоники вы-

ходного тока модулятора. Получив входной сигнал V3 и АМ-
сигнал на выходе контура Vr, использовать спектральное пред-

ставление АМ-сигнала на выходе колебательного контура, полу-
ченное при подключении функции fs() (функция фурье-

преобразования) на этапе отображения данных. Амплитуду моду-
лирующего колебания V2 задать равной нулю. Изменить напряже-
ние V1 от 0,4 до 1,2 В c помощью операций моделирования Var, 

DC, Parameter Sweep. 
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16. Для изменения параметра V_DC источника необходимо вне-
сти в окно схемного редактора контроллер описания переменной 
величины VAR. В окно свойств контроллера VAR ввести имя пере-

менной и ее начальное значение. Ввести в окно схемного редактора 
контроллер DC-анализа, в окно свойств DC-контроллера — имя из-

меняемой переменной (Parameter to Sweep), тип и диапазон значе-
ний изменения параметра в соответствии с заданием. Внести в окно 
схемного редактора контроллер изменения параметров Parameter 

Sweep, в окно свойств контроллера Parameter Sweep ввести имя из-
меняемой переменной (Parameter sweep), тип и диапазон значений 

изменения параметра в соответствии с заданием. На закладке Simu-
lations ввести имена контроллеров DC-анализа (DC1) и Transient-
анализа (Tran1).  

 

 
 

Рис. 3.8. Спектр выходного сигнала и модуляционная  

характеристика амплитудного модулятора 

 

17. Провести моделирование. Построить модуляционную ха-
рактеристику как зависимость амплитуды первой гармоники вы-

ходного тока Ic1 от изменения напряжения смещения Eб на входе 
модулятора (V1) в окне отображения данных, используя результа-
ты моделирования, полученные в спектральной форме.  

18. Результат моделирования получить в окне отображения 
данных (рис. 3.8). По модуляционной характеристике найти значе-

ние постоянного смещения Eб (V1), обеспечивающего модуляцию 
без искажений (середина линейного участка) и значение допус-
каемого коэффициента модуляции m, при котором не происходит 

нелинейных искажений.  
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Рис. 3.9. Зависимость коэффициента модуляции  

от амплитуды модулирующего напряжения 
  

19. Исследовать зависимости коэффициента модуляции m от 
амплитуды модулирующего напряжения (V2). Исследование про-
водить для напряжения смещения (V1), соответствующего середи-

не линейного участка модуляционной характеристики. Модули-
рующий сигнал (амплитуда генератора V2) изменять в диапазоне 

0,05…0,4 В. Измерение коэффициента модуляции m проводить по 
спектральным компонентам выходного сигнала, снимаемого с ко-

лебательного контура. Амплитуду несущего колебания задать в 
виде A1=0.4 V (V2) — рис. 3.9. 

 

 

Рис. 3.10. Характеристика детектирования амплитудного детектора 

 

20. Получить характеристику детектирования как зависи-
мость напряжения на выходе детектора det от амплитуды высо-

кочастотного сигнала Vr (рис. 3.10). Задать напряжение постоян-
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ного смещения на базе Eб (V1) равным значению, соответствую-
щему середине линейного участка модуляционной характеристи-
ки. Амплитуду высокочастотного сигнала изменять в пределах от 

0,05 до 0,4 В. Определить границы линейного участка характери-
стики. 

 

3.4. Содержание отчета 

1. Цель работы и задание. 
2. Краткие сведения о методах анализа переходных процессов. 

3. Графики зависимостей, расчетные параметры, полученные 
на каждом этапе выполнения задания. 

4. Выводы по каждому пункту исследований. 
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